
How to Calculate Multiple Hatch Areas in
AutoCAD: The Ultimate Guide

Description

AutoCAD is a powerful software tool that can be used to create detailed drawings and designs. One of
the most useful features of AutoCAD is the ability to calculate the area of objects, including hatches. In
this article, we will explore how to calculate multiple hatch areas in AutoCAD, including irregular
shapes and groups of objects.

Whether you are an architect, engineer, or designer, knowing how to calculate area in AutoCAD is an
essential skill that can save you time and improve the accuracy of your work. By the end of this article,
you will have a solid understanding of how to calculate multiple hatch areas in AutoCAD, and be able
to apply this knowledge to your own projects.

Key Takeaways

The Region command can be used to calculate the area of a group of objects or an irregular
shape in AutoCAD.
The Hatch command can be used to add a hatch to a closed boundary or polyline, and the Hatch
Area tool can be used to calculate the area of a hatch.
The HatchEdit command can be used to merge or edit hatches in AutoCAD.
The List and Area commands can be used to calculate the area of an object or a closed polyline.
The AreaLabel command can be used to create an automatic area label in AutoCAD.

Understanding Hatching in AutoCAD

Before we dive into the topic of calculating hatch areas, let’s take a quick look at what hatching is and
how it works in AutoCAD.

In AutoCAD, hatching is a process of filling a closed boundary with a pattern of lines, dots, or other
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shapes. This pattern is called a hatch pattern, and it is defined by a set of properties such as angle,
scale, and spacing.

To apply a hatch pattern to a closed boundary, you need to first define the boundary using a closed
polyline, a circle, or any other closed shape. Then, you can use the Hatch command in AutoCAD to
select the boundary and specify the hatch properties.

Once you apply a hatch pattern to a boundary, you can modify the properties of the hatch pattern using
the Hatch Editor, which allows you to change the angle, scale, spacing, and other properties of the
hatch pattern.

Calculating Hatch Areas for Single Boundaries

Now that you have a basic understanding of hatching in AutoCAD, let’s move on to the topic of
calculating hatch areas. We will start by discussing how to calculate the hatch area for a single
boundary.

To calculate the hatch area for a single boundary, you can use the List command in AutoCAD. Here
are the steps:

1. Select the boundary for which you want to calculate the hatch area.
2. Type “List” in the command line and press Enter.
3. AutoCAD will display a list of properties for the selected object, including the Area property.
4. Look for the “Area” property in the list and note down the value.

That’s it! You have now calculated the hatch area for a single boundary.

Calculating Hatch Areas for Multiple Boundaries

Calculating the hatch area for a single boundary is relatively easy, but what if you have multiple
boundaries that you need to calculate the hatch area for? Fortunately, AutoCAD provides several tools
and techniques for handling multiple boundaries.

Method 1: Using the Area Command

The first method for calculating hatch areas for multiple boundaries is to use the Area command in
AutoCAD. Here are the steps:

1. Select all the boundaries for which you want to calculate the hatch area.
2. Type “Area” in the command line and press Enter.
3. AutoCAD will display the total area of all the selected boundaries.
4. Look for the “Hatch” area value in the list and note down the value.

Note that the Area command can also be used to calculate the area of other types of objects, such as
circles, polygons, and regions.
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Method 2: Using the List Command with Select Similar

The second method for calculating hatch areas for multiple boundaries is to use the List command in
combination with the Select Similar command. Here are the steps:

1. Select one of the boundaries for which you want to calculate the hatch area.
2. Type “List” in the command line and press Enter.
3. AutoCAD will display a list of properties for the selected object, including the Area property.
4. Look for the “Area” property in the list and note down the value.
5. Type “Select Similar” in the command line and press Enter.
6. AutoCAD will select all the boundaries in the drawing that have the same properties as the

selected boundary.
7. Type “List” in the command line and press Enter again.
8. AutoCAD will display a list of properties for all the selected objects, including the Area property.
9. Look for the “Area” property in the list and note down the total value.

This method allows you to calculate the hatch area for all the boundaries that have the same properties
as the selected boundary. For example, if you have a drawing with multiple rooms that have the same
wall thickness and hatch properties, you can select one of the rooms, use the List and Select Similar
commands to select all the rooms, and then calculate the total hatch area for all the rooms.

Method 3: Using the Hatch Area Tool

The third method for calculating hatch areas for multiple boundaries is to use the Hatch Area tool in
AutoCAD. Here are the steps:

1. Type “Hatch Area” in the command line and press Enter.
2. AutoCAD will prompt you to select the hatch objects for which you want to calculate the area.
3. Select all the hatch objects that you want to calculate the area for.
4. AutoCAD will display the total hatch area for all the selected objects.

This method allows you to quickly calculate the hatch area for all the hatch objects in the drawing,
regardless of whether they are attached to boundaries or not.

Handling Complex Hatch Patterns

So far, we have discussed how to calculate hatch areas for simple hatch patterns that are attached to
closed boundaries. But what if you have more complex hatch patterns, such as hatches with gradients,
textures, or irregular shapes?

AutoCAD provides several tools and techniques for handling complex hatch patterns. Here are a few
examples:

Using the Hatch Editor to modify the properties of the hatch pattern, such as angle, scale, and
spacing.
Using the Boundary command to create a boundary around the irregular shape and then applying
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the hatch pattern to the boundary.
Using the Region command to convert the irregular shape into a region and then applying the
hatch pattern to the region.

These techniques allow you to create complex hatch patterns and calculate their areas accurately.

FAQ: How to calculate multiple hatch area in AutoCAD?

1. How do I find the area of a group in AutoCAD?

To find the area of a group in AutoCAD, you can use the Region command. Here’s how:

1. Select all the objects that you want to group.
2. Type “Region” in the command line and press Enter.
3. AutoCAD will convert the selected objects into a single region.
4. Type “List” in the command line and press Enter.
5. AutoCAD will display a list of properties for the selected region, including the Area property.
6. Look for the “Area” property in the list and note down the value.

Alternatively, you can use the Hatch Area tool to find the area of a group of hatch objects. Here’s how:

1. Type “Hatch Area” in the command line and press Enter.
2. AutoCAD will prompt you to select the hatch objects for which you want to calculate the area.
3. Select all the hatch objects that you want to group.
4. AutoCAD will display the total hatch area for all the selected objects.

2. How do you calculate irregular area in AutoCAD?

To calculate the area of an irregular shape in AutoCAD, you can use the Region command. Here’s how:

1. Draw a closed polyline around the irregular shape.
2. Type “Region” in the command line and press Enter.
3. AutoCAD will convert the polyline into a region.
4. Type “List” in the command line and press Enter.
5. AutoCAD will display a list of properties for the selected region, including the Area property.
6. Look for the “Area” property in the list and note down the value.

Alternatively, you can use the Hatch command to hatch the irregular shape, and then use the Hatch
Area tool to calculate the area of the hatch. Here’s how:

CADDIKT
https://caddikt.com/

https://c
addikt.com/

Page 4
https://caddikt.com/



1. Select the irregular shape.
2. Type “Hatch” in the command line and press Enter.
3. Select a hatch pattern and specify the properties.
4. Type “Hatch Area” in the command line and press Enter.
5. AutoCAD will prompt you to select the hatch objects for which you want to calculate the area.
6. Select the hatch objects.
7. AutoCAD will display the total hatch area for all the selected objects.

3. How do you add hatched areas in Civil 3d?

To add hatched areas in Civil 3D, you can use the Hatch command. Here’s how:

1. Select the boundary for which you want to add a hatch.
2. Type “Hatch” in the command line and press Enter.
3. Select a hatch pattern and specify the properties.
4. AutoCAD will apply the hatch pattern to the selected boundary.

Alternatively, you can use the Area Hatch/Fill tool in Civil 3D. Here’s how:

1. Select the boundary for which you want to add a hatch.
2. Click on the Area Hatch/Fill tool in the Home tab.
3. Select a hatch pattern and specify the properties.
4. Civil 3D will apply the hatch pattern to the selected boundary.

4. How do you merge hatches in AutoCAD?

To merge hatches in AutoCAD, you can use the HatchEdit command. Here’s how:

1. Select the hatch objects that you want to merge.
2. Type “HatchEdit” in the command line and press Enter.
3. AutoCAD will open the Hatch Editor.
4. Click on the “Combine” button in the Hatch Editor.
5. AutoCAD will combine the selected hatch objects into a single hatch.

Alternatively, you can use the Hatch command to create a new hatch that covers the entire area of the
merged hatched objects. Here’s how:

1. Select the hatch objects that you want to merge.
2. Type “Hatch” in the command line and press Enter.
3. Specify the properties for the new hatch, such as the pattern and angle.
4. Select a point inside the area that you want to cover with the hatch.
5. AutoCAD will create a new hatch that covers the entire area of the merged hatch objects.

5. How do you calculate area in m2 in AutoCAD?
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To calculate area in square meters (m2) in AutoCAD, you can use the List command. Here’s how:

1. Select the object for which you want to calculate the area.
2. Type “List” in the command line and press Enter.
3. AutoCAD will display a list of properties for the selected object, including the Area property.
4. Look for the “Area” property in the list and note down the value.
5. If the value is in square units other than square meters, such as square millimeters or square

centimeters, convert it to square meters by dividing by the appropriate conversion factor.

Alternatively, you can set the units for the drawing to square meters using the Units command. Here’s
how:

1. Type “Units” in the command line and press Enter.
2. In the Drawing Units dialog box, select “Square Meters” in the Insertion Scale tab.
3. Click OK to save the changes.
4. AutoCAD will now display all area values in square meters.

6. Why do some hatches not show area?

If a hatch does not show area in AutoCAD, it may be because the hatch is not properly enclosed by a
boundary or polyline. To calculate the area of a hatch, AutoCAD requires a closed boundary or polyline
that completely encloses the hatch. If the boundary or polyline is not closed or has gaps, AutoCAD
may not be able to calculate the area.

To fix this issue, make sure that the boundary or polyline is completely closed and has no gaps. You
can also try using the Region command to convert the hatch into a region, which will ensure that the
area is calculated accurately.

7. How do you subtract a hatch in AutoCAD?

To subtract a hatch from an object in AutoCAD, you can use the Subtract command. Here’s how:

1. Draw a closed polyline around the area that you want to subtract the hatch from.
2. Type “Subtract” in the command line and press Enter.
3. Select the hatch object that you want to subtract.
4. Select the polyline that you drew in step 1.
5. AutoCAD will subtract the hatch from the selected area.

Alternatively, you can use the Region command to convert the hatch into a region, and then use the
Subtract command to subtract the region from the selected area.

8. How do you explode hatch in AutoCAD?

To explode a hatch in AutoCAD, you can use the Explode command. Here’s how:

1. Select the hatch object that you want to explode.
2. Type “Explode” in the command line and press Enter.
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3. AutoCAD will explode the hatch into its component lines and arcs.

Note that exploding a hatch may cause the area to be lost, as the hatch properties will be removed. To
preserve the area, you may need to convert the hatch into a region before exploding it.

9. How do you trim a hatch?

To trim a hatch in AutoCAD, you can use the Trim command. Here’s how:

1. Draw a closed polyline around the area that you want to trim the hatch from.
2. Type “Trim” in the command line and press Enter.
3. Select the hatch object that you want to trim.
4. Select the polyline that you drew in step 1.
5. AutoCAD will trim the hatch to the selected area.

Alternatively, you can use the Hatch Trim tool in the Modify tab. Here’s how:

1. Select the hatch object that you want to trim.
2. Click on the Hatch Trim tool in the Modify tab.
3. Specify the trimming boundary by selecting a polyline or specifying a point.
4. AutoCAD will trim the hatch to the selected area.

10. How do you calculate the area?

To calculate the area of an object in AutoCAD, you can use the List command. Here’s how:

1. Select the object for which you want to calculate the area.
2. Type “List” in the command line and press Enter.
3. AutoCAD will display a list of properties for the selected object, including the Area property.
4. Look for the “Area” property in the list and note down the value.

Alternatively, you can use the Area command to calculate the area of a closed polyline or region.
Here’s how:

1. Type “Area” in the command line and press Enter.
2. Select a closed polyline or region.
3. AutoCAD will display the total area for the selected object.

11. How is Progecad area calculated?

The area in ProgeCAD is calculated using the same methods as AutoCAD. To calculate the area of an
object in ProgeCAD, you can use the List command or the Area command, as described above.

12. How do I create an automatic area in AutoCAD?

To create an automatic area label in AutoCAD, you can use the AreaLabel command. Here’s how:

1. Type “AreaLabel” in the command line and press Enter.
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2. Select the object for which you want to create the area label.
3. AutoCAD will display the area label for the selected object.

You can also customize the area label by specifying the text style, height, and other properties.

13. Which command is used to determine the area?

The command used to determine the area in AutoCAD is the List command or the Area command, as
described above.

14. How do you add area in CAD?

To add area in CAD, you can use the Hatch command to add a hatch to a closed boundary or polyline.
You can also use the Region command to convert an irregular shape into a region, and then add a
hatch to the region. The area of the hatch or region will be calculated automatically.

15. How do you calculate the area of an irregular shape?

To calculate the area of an irregular shape in AutoCAD, you can use the Region command or the
Hatch command, as described above. You can also draw a closed polyline around the irregular shape
and use the List command or the Area command to calculate the area.

Videos:

Conclusion

Calculating multiple hatch areas in AutoCAD is a crucial aspect of creating accurate and detailed
drawings. By using the various commands and tools available in AutoCAD, you can quickly and easily
calculate the area of hatches, groups of objects, and irregular shapes. It is important to keep in mind
that the accuracy of your calculations depends on the quality of your drawings and the boundaries you
use.

As you continue to work with AutoCAD, you will develop a deeper understanding of how to use these
tools and commands effectively. By taking the time to master these skills, you can improve the quality
of your work and become a more efficient and effective designer, engineer, or architect.
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